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PLEASE READ THIS INFPLEASE READ THIS INFORMATION BEFORE INSTORMATION BEFORE INSTALLING THE SOFTWARE.ALLING THE SOFTWARE.  
Personnel 

Qualified personnel should carry out installation, operation and maintenance of the software. A qualified person is 
someone who is technically competent and familiar with the installation process, operation and maintenance of this 
software. 

 
Procedures in this manual may contain Warnings and Notes.  A Warning gives the reader the information, which, if 
disregarded, could cause injury or death.  A Note furnishes additional information for added emphasis or clarity.  

 

The customer is responsible for assessing his or her ability to carry out the procedures in this manual.  Make sure you 
understand a procedure or the precautions necessary to carry it out safely before beginning.  If you are unsure of your 
ability to perform a function, or have questions about the procedures listed in the manual, contact Eurotherm Drives, 
Inc. customer service at (704) 588-3246. 

 

WARNING!WARNING!  
This software is used specifically to configure the control of potentially dangerous motor control.  The 
user assumes all liability and risk for the performance, application, and reliability of all control systems 
configured with this software.  It is the users responsibility to understand thoroughly and to check 
independently all configurations before commissioning any equipment controlled by this software.  
Eurotherm Drives, Inc. accepts no liability for the application of the software. 
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Chapter Chapter 11  IntroductionIntroduction  

WHAT IS CONFIGED LITWHAT IS CONFIGED LITE PLUSE PLUS  
ConfigEd Lite Plus (CELite+) is Eurotherm Drives’ newest configuration editor software suite for drives. This 
enhanced software package supports all current-production Eurotherm Drive products. 

Windows-based CELite+ provides you with the ability to adjust all drive parameters, autotune your application and 
chart key variables while on-line!  It’s like having a built-in chart recorder where you can monitor trends in load, speed, 
and other operating conditions. You will benefit by your ability to monitor conditions as changes are made to 
production rates, process and material changes.    

The actual application programming still uses the ConfigED Lite (CELite) software tool which will run in the 
background of CELite+.  

DRIVE COMPATIBILITYDRIVE COMPATIBILITY  
590+ Series Digital DC Drives, All Firmware versions. 

650V Series Digital AC Drives, Firmware 4.2 or newer. 

690+ Series Digital AC Drives, Firmware 4.6 or newer. 

 

NoteNote  
All unlisted drives are only compatible with CELite, except for 650 series which does not support either. 

MINUMUM SYSTEM REQUIMINUMUM SYSTEM REQUIREMENTSREMENTS  
CELite + is designed to be used with PC’s equipped with: 

• Pentium II 233MHz or better 

• 800x600 screen resolution, supported by Microsoft Windows 

• Microsoft Windows 98 or later, or Microsoft Windows NT 4.0 or later 

• 24 MB RAM for Windows 98, 32 MB for Windows NT 

• Microsoft Internet Explorer version 4.01 or later (version 4.01 Service Pack 1 or later for DHTML application 
developers, and 4.x for end-users of these applications). 

• 12 MB hard drive space required. 

• Standard RS232 Serial port with 9 pin male connector. (Special adapters for USB serial ports are available from 
Eurotherm Drives.) 
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NOISENOISE  
Ground noise may disturb the P3 serial communications link. It is created by ground loops caused when both the 
computer and the drive are grounded. CELite+ has a built-in retry routine to deal with occasional electrical noise. 
Continuous noise, however, will cause extremely slow communications between the computer and the drive. 

In systems with large amount of electrical noise (for example, systems containing AC drives) it may be necessary to 
break the ground loop to achieve usable communications. The ground loop can be broken by: 

• Using a battery-powered notebook computer rather than a plug-in model since most notebook computers are not 
grounded. 

• Installing an RS232 isolator module between the computer and the P3 socket. 

• Wrapping the UDP cable through ferrite rings on both ends of the cable. 

 

WARNING!WARNING!  
Do not use any connectors, adapters, and/or cables other than those supplied by Eurotherm Drives. Failure 
to use materials supplied by Eurotherm Drives can result in severe damage to equipment and injury to 
personnel and will void the Eurotherm Drives warranty. 
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Chapter Chapter 22  HandlingHandling  

UNPACKING INSTRUCTIOUNPACKING INSTRUCTIONSNS  

 
Before you install and use CELite+, verify the completeness of your package. It should include: 

• CELite+ user manual (Part Number HA470795U000) 

• Installation CDROM and case (Part Number RD470795) 

• UDP cable and adapter (Part Number CM351909) 

• User License for CELite+ 

If any item on this list is missing, contact the Eurotherm Drives Customer Service at 704-588-3246. 

SPECIAL HANDLINGSPECIAL HANDLING  
 

Proper care must be shown in the handling of the materials used for the program. The installation disk should be kept in 
a clean, dry environment within a relatively constant range of temperature and humidity. Keep the CELite+ disk far 
from any sources of extreme heat, magnetism and electrical fields, including permanent magnet motors, as the magnetic 
or electrical fields may erase the information on the disk. 

 

WARNING!WARNING!  
CELite+ is a powerful software tool specifically designed to configure drives. It is possible to create 
potentially dangerous drive configurations. The user assumes all liability and risk for the performance, 
application, reliability, and safety of drives implemented using this tool. It is the responsibility of that user 
to understand the configurations thoroughly and check them independently prior to installations and 
operation of any equipment. Eurotherm Drives can accept no liability for the application of this software. 
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Chapter Chapter 33  Installation Installation & Setup& Setup  
 

WARNING!WARNING! 
Please Uninstall (remove) all previous versions of CELite+ prior to Installation.  This may include the 
manual removal of a DeskTop Icon. 

INSTALLATION PROCEDUINSTALLATION PROCEDURERE  

Autorun Install 
With Windows launched, insert the CELite+ CDROM disk into your CD Drive. The install program should launch 
automatically, if not follow the manual installation procedure. 

 

Manual Install 
Using the cursor click on the Start button on the desktop, then click on RUN.  

 

When the run dialog box appears, type in the drive letter for your CD Drive. If you do not know your CD Drive letter, 
click on browse to search for it. In this example the CD drive letter is D. Type d:\setup and then click OK. 

 



Chapter 3 Installation & Setup 

 6 ConfigEd Lite Plus 

The following window will appear to show you that the CELite+ installation has begun, click on OK to continue. 

 

This window will show the folder where the program will be installed on the hard drive. Click on the Computer 
button to proceed to the next step of installation.  

 

IMPORTANTIMPORTANT  
Please do not change the installation directory. 
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The following window will appear to show the program group where the CELite+ shortcut will be installed. Click on 
the Continue button to proceed to the next step of installation. 

 

After the program group has been selected, the program will start copying files to your hard drive. The following status 
window will appear to show you the progress of the installation.  It is not uncommon for error messages or file copy 
messages to appear during this procedure.  Error messages should be copied in the unlikely event they need to be 
reported although they should be otherwise ignored.  As long as the application being deployed is known to be the 
“latest”, always replace an existing file if prompted. 

 

After the program is finished loading the files, the following window will appear. Click on OK to finish the installation. 
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STARTING THE PROGRAMSTARTING THE PROGRAM  
Start the program by either clicking on the CELite+ shortcut on the desktop or using the start menu. 

 

To use the start menu, click on Start, then Programs, then the Eurotherm Drives program group, then on the 
CELPlus shortcut 

CHOOSING THE DRIVECHOOSING THE DRIVE    
After launching the program, click on the button for the desired drive series.  The initial loading of data may take a 

few minutes on slower systems. 
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DRIVE COMMUNICATION DRIVE COMMUNICATION SETUPSETUP 
Eurotherm Drives contain a serial port socket, similar to a telephone handset socket, for RS232 communication to the 
CELite+ software. This port is commonly referred to as the P3 port. Please refer to the drive manual for location and 
setup of the port on the drive. 

 

TIPTIP  
On smaller horsepower AC drives, 5 hp and below, the keypad must be removed and the serial cable 
plugged into the keypad serial port. Larger horsepower AC drives 7.5 hp and above, have a separate P3 
serial port. All DC drives have a separate P3 serial port. 

WARNING!WARNING!  
Do not use any connectors, adapters, and/or cables other than those supplied by Eurotherm Drives. 
Failure to use materials supplied by Eurotherm Drives can result in severe damage to equipment and 
injury to personnel, and will void the Eurotherm Drives warranty. 

TOGGLING BETWEEN THETOGGLING BETWEEN THE PROGRAMS PROGRAMS 
The following figures show the proper way to switch between CELite+ and CELite. Just click on the button or menu 
shown to switch between the programs. 

                                  GO TO CELite 

               GO TO CELite+ 

 

WARNING!WARNING! 
Do not use the Windows task bar to switch between the programs. If the task bar is used, the programs 
will not work properly. 

PRINTER SETUPPRINTER SETUP  
Before using CELite+, the program needs to be setup for printing the configurations.  

 

CautionCaution 
If the only printer configured on the computer is a network printer, the program will not work properly 
when not connected to the network. A local printer has to be configured on the computer and set as 
default, when no network connection is available.   
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Click on the Graphics button to go to CELite, then on File, then Page Setup. 

 

The following window will show the default printer and allow a different printer and other printing options to be 
selected.   

 

Since CELite creates drawings in a horizontal format, make sure your page is set for Landscape mode. When you are 
finished click the OK button. 
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Chapter Chapter 44  Creating a Drive ConfigurationCreating a Drive Configuration  

PREPARING THE DRIVEPREPARING THE DRIVE  
Before launching the program, verify that the drive is set to factory defaults. Refer to the drive manual for instructions 
on how to reset the drive. Resetting the drive will ensure there are no left over parameters that may effect operation. 

OPENING A DEFAULT COOPENING A DEFAULT CONNFIGURATIONFIGURATION  
To begin, launch the program and open a default configuration (refer to Chapter 3). Once the home screen appears in 
CELite+, click on the Online button. If CELite+ is connected to the proper drive and communicating, the status bar 
below will appear. 

If CELite+ is not connected to the proper drive or if the communications are not setup, the following error message will 
appear. Click on Retry, if unsuccessful, Click on Reset under the Comms menu. If still unsuccessful, review the 
communications setup in chapter 3. 

After CELite+ is done retrieving the tags from the drive, the Online button should turn green.   

NOTENOTE  
If the Online is yellow, which means cautions, check the status bar for faults. 

Now, the default CELite configuration needs to be updated, click on the Update button shown below.  

CELite+ will go offline temporarily, and then upload the drive information to the CELite configuration. 
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IMPORTANTIMPORTANT  
Do not click on anything until CELite+ is done updating the CELite configuration. The program will go 
back online once it is finished. 

NOTENOTE  
The configuration in CELite must be updated before proceeding. Updating the configuration will pull in 
drive specific parameters that set the size of the power section of the drive. Updating the CELite 
configuration must be completed, if creating a new configuration or editing an existing configuration. 

 
If any of the parameters are out of range, the following message will appear. Write down the parameter number so it 
can be changed while editing the configuration in CELite. Click on OK to continue. 

EDITING A DEFAULT COEDITING A DEFAULT CONFIGURATIONNFIGURATION  
Now that the configuration has been updated, click on the Graphics button to edit the default configuration in 
CELite. Each series of drive will have minor differences in the way the configurations look and the blocks used, but the 
editing is done in the same manner. This example shows a 690+ drive. 

This is a graphical diagram of the default 690+ drive configuration containing the standard drive functions blocks and 
connections.  The second title bar shows the name of the configuration file. 
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DISPLAYING THE CONFIDISPLAYING THE CONFIGURATIONGURATION  
There are a variety of Windows™ controls available to enhance viewing of the configurations. To enlarge the CELite 
window to fill the monitor screen, click on the zoom box in the upper right corner of the window. Clicking again on the 
box will return the window to its previous size. 

Notice the gray outline frame near the bottom and right side of the CELite window. If the gray outline is not visible, try 
scrolling down or to the right until it appears. This frame marks the limits of the “page” on which the configuration is 
drawn. There must be an extra margin inside the gray outline for the edges of the paper where the printer cannot print. 
Items extending beyond the gray outline will not print. 

The CELite window can be re-sized by moving the mouse pointer to either an edge or a corner of the window until it 
changes into a two-pointed arrow. Then hold the left mouse key down and drag the window edge to the size wanted. 

To get the configuration window to appear in the CELite window, press the Shift key while selecting the appropriate 
configuration from the Window menu. This is especially useful if using a small screen and the configuration desired 
gets “lost” on the desktop. 

The view inside the window can be enlarged or reduced from the keyboard by using the number keys (either at the top 
of the keyboard or on the numeric keypad), the + or - keys, or by choosing a different Scale size in the Draw menu. 
The arrow keys and the Page Up and Page Down keys modify the view of and/or move the drawing within the 
CELite window. For a complete list of keyboard commands, see the following table. 

 

Keyboard CommandsKeyboard Commands  
KeystrokeKeystroke   RResultesult 

3   Scales to 3pt. font (0.50x drawing); 
   homes drawing to upper left corner 
4   Scales to 4pt. font (0.67x drawing); 
   homes drawing to upper left corner 
5   Scales to 5pt. font (0.83x drawing) 
6   Scales to 6pt. font (1.00x drawing) 
7   Scales to 7pt. font (1.17x drawing) 
8   Scales to 8pt. font (1.33x drawing) 
9   Scales to 9pt. font (1.50x drawing) 
0   Scales to 10pt. font (1.67x drawing) 
1   Scales to 11pt. font (1.83x drawing) 
2   Scales to 12pt. font (2.00x drawing) 
+   Increases scaling by factor of 1.33 
-   Decreases scaling by factor of 1.33 

Home  Sets origin of view to upper left corner 
Page Up  Moves view of drawing up by 7/8 of current size 
Page Down  Moves view of drawing down by 7/8 of current size 
Up arrow  Nudges view of drawing up 
Down arrow  Nudges view of drawing down 
Left arrow  Nudges view of drawing to the left 
Right arrow  Nudges view of drawing to the right 
Shift Page Up  Moves view of drawing to previous sheet 
Shift Page Down  Moves view of drawing to next sheet 
Backspace  Deletes currently-selected item 
 

 

The mouse pointer can be used to select an area of the drawing to enlarge. Determine the area of the drawing desired to 
be enlarged, then hold down the mouse key and “draw” a box around that area. When the mouse key is released, the 
area selected will fill the window. A function block must be included somewhere in the area selected for this feature to 
work. 
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CONFIGURATION CONFIGURATION PARAMETERSPARAMETERS  

Displaying Parameters 
To display the parameters of a particular function block, double-click on the desired block with the left mouse button. 
This brings up a window listing all the parameters for that function block and its connections. 

 

NOTENOTE  
Since all connections will be made on screen in graphical mode, the fields for connections are there for 
informational purposes only. Connections may not be set in this window. 

 

Changing Parameters 
To change non-numeric parameters (for example, on/off or positive/negative), double-click on the 
appropriate field in the parameter list window. A list of optional choices will appear to choose from. 

For a numeric field (for example, 0.500 seconds or 0.50%), click once on the field to highlight the numeric figure, 
then type in the new value to assign to the field. When finished entering the changes, close the parameter window to 
update and return to the configuration drawing. 

MAKIMAKING CONNECTIONSNG CONNECTIONS  

NOTENOTE  
Before creating any new or changing any existing connections in the default configuration, refer to the 
product manual for your drive. 

Connections between function blocks (or in special cases between outputs and inputs on the same function block) are 
made by “drawing” the connection from an output on one block to input on the other. To see how this is done, use the 
mouse to select and then enlarge the view of a pair of function blocks. 

As the mouse pointer is moved close to an output on one of the blocks, it will turn into a crosshair. 
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With the crosshair showing, click the left mouse button once to make the initial connection with the output of the first 
function block. As the mouse is moved away from the output connection, the crosshair turns back into a pointer and a 
dashed line follows the mouse's movement. 

Move in the direction of the input connection on the second function block (or, in special cases, to the same function 
block). When approaching the input connection, the pointer will once again turn into a crosshair. Click on the input 
connection and the now solid line will extend from the output connection to the input connection. 

If a connection is made incorrectly, click on the connecting line. The line will become dashed. Press the Delete or 
Backspace key to delete the connection. 

The routing of connection lines may also be adjusted to make the configurations easier to read. Click on the line desired 
to be moved and drag the segment to the desired location. Its connections will remain intact but the line will follow the 
new path. 

 

NOTENOTE  
 Some function blocks (for example, analog and digital inputs) support only one connection per output. If 
more than one connection is drawn from one of their outputs, the following error message will appear. 

 

 

Delete a connection and proceed. This message may also appear if the number of common connections allowed in a 
drive configuration, currently ten, has been exceeded. Special or dedicated connections are not included in this limit. 
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INTERINTER--SHEET CONNECTISHEET CONNECTIONSONS  
CELite allows drawing connections between function blocks on different sheets. This is an important and valuable 
feature since drive configurations cover more than one sheet. To make inter-sheet connections: 

1. Begin a connection from an output terminal of a function block on sheet1. 

2.  Move the mouse pointer to the Draw menu and select Next Sheet. A dashed line for the connection will 
appear attached to your mouse pointer. 

3. Complete the connection to an input terminal on the second function block. The dashed line will change to a solid   
line. It will be labeled with generic text identifying the connection and the source sheets (for example, ITEM 1 
SHT 1). 

 On the previous sheet, the text will show the destination sheet for the connection (for example, ITEM 1 
SHT 2). 

4.  Rename the connection by double-clicking on the arrow or the descriptive text to bring up a dialog box. 

 
 Enter the preferred label name. The new information will appear on both sheets. 
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SPLIT CONNECTIONSSPLIT CONNECTIONS  
Similar to inter-sheet connections, split connections can help keep complex configurations from being cluttered with an 
abundance of crossing lines. Split connections resemble inter-sheet connections in that they include labels identifying 
their source and destination. Split connections may also be made in read-only configurations, since only the on-screen 
appearance has been modified and the connection itself has not been changed. To draw a split connection: 

1. Choose a connection between two distant function blocks. 

2. Double-click on the connection with the mouse pointer or click once and press the Enter key. A dialog box will ask 
for a name for the connection. 

 

3. Enter the name and click the OK button. The connection will be split and labels will be attached to each end   
identifying the source and destination of the connection. 

To change the connection name, double-click on either the connection or the label and enter the new information in the 
dialog box. 

ALIGNING FUNCTION BLALIGNING FUNCTION BLOCKSOCKS  
Function blocks can be moved in the drawing to straighten out and neaten the appearance of the configuration, even 
when they are connected. Place the mouse pointer on the object to be moved, hold down the mouse button, and drag it 
to its new location. When satisfied with its position, release the mouse button. 

Aligning elements within the configuration drawing can be easily accomplished. To align a series of function blocks, 
either vertically or horizontally, click on the one in the position planed to be used as a master. Go to the Draw menu 
and select Align. 

A check mark will appear next to Align to show that the alignment feature is operational.  The alignment feature 
works on only the top or left side of the objects being aligned. 

Select each element desired to be aligned with the master, drag it to the general location desired, and release the mouse 
button. CELite will automatically snap it into alignment with the original element. CELite “senses” whether the most 
appropriate alignment is in the vertical or horizontal plane and moves the element accordingly. The alignment feature 
can be turned off by clicking on an empty section of the drawing (so no function block is selected) and selecting Align 
again. The check mark will now be gone, showing that the alignment feature is toggled off. 
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SAVING A CONFIGURATISAVING A CONFIGURATIONON  
Once all changes and adjustments have been made to the configuration it should be saved. The configuration can only 
be saved in CELite+, so switch back to CELite+ by clicking on CELite+ then CELite+. To save the configuration 
to the same name, click on File then Save. If this is the first time saving the configuration (for example, New was 
selected from the File menu to open the default configuration), select Save As from the File menu.  

 

This brings up a dialog box in which the name of the configuration, being saved, is typed. 

The default directory for saving new configurations is the CELite+ directory. Additional directories should be created to 
organize the configurations according to particular job needs. In this example, a subdirectory called New has been 
created in which the test_1.590 configuration will be saved. Consult the Windows™ manual for further 
instructions. 

A primary reason to organize the configurations in separate directories is to keep the appropriate database with them. 
Copy the celite.dat file (the ConfigEd Lite database) into the same directory as the configurations at the same time 
the configuration is saved to the directory. This will preserve a copy of the database as it existed when the configuration 
was created and avoid possible incompatibilities between older and updated .dat files. 

Once the correct directory has been located, type in the new name for the configuration without changing the extension 
and click on the OK button to save it to that directory. 

INSTALL A CONFIGURATINSTALL A CONFIGURATIONION  
In order to install the configuration into the drive, the computer being used must be connected to that drive’s P3 port. 
Once your configuration is completed, saved and checked, it is ready to be installed into the drive. The configuration 
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can only be installed from CELite+, so switch back to CELite+ by clicking on CELite+ then CELite+. Go Online 
by clicking on ONLINE. After going online, click on the Install button to begin the installation process to the drive. 

 

When the configuration is downloaded into the drive it replaces those parameters existing in the drive. A status box 
displays the progress of the Install procedure. 

 

WARNING!WARNING!  
Installing new configurations into a drive must only be done when the drive is in a stopped and safe 
condition. Errors in the configuration may cause unexpected and/or dangerous consequences in the 
control system. It is imperative that all configurations be checked and tested by a qualified engineer 
BEFORE installing them into drives and putting them into service.   

NoteNote  
 All other serial ports in the controller must be disabled before communicating through the P3 port. 

   

CREACREATING CONFIGURATION TTING CONFIGURATION TEMPLATESEMPLATES  
Template files are useful for reusing configurations and creating standard graphical presentations. They are not 
overwritten when saving a configuration. 

To create a template, open a configuration and modify it as needed. Select Save As in the File menu. Change the 
destination directory to \CELite+\new and choose OK to close the configuration file. This file will appear in the pop 
down menu when selecting New in the File menu. 

OPENING AOPENING AN EN EXXISTING CONFIGURATIONISTING CONFIGURATION  
Once a configuration has been saved, CELite+ will display the configuration name in the File Open menu list as 
long as the proper directory is selected. To open an existing configuration, click on File then Open and the name of 
the desired configuration. 

UPDATING A CONFIGURAUPDATING A CONFIGURATIONTION  
To retrieve a copy of the drive’s parameter settings or configuration, use the update function on the CELite+ home 
screen. Open the configuration file to be updated, if it is not already open. After going Online, click the Update button 
from the CELite+ Home screen, to replace the configuration parameters with those from the drive. A status box displays 
the progress of the update procedure. 

NNOTEOTE  
The Update function will overwrite all the connections and parameter settings of the currently selected 
configuration. Make sure you do not accidentally overwrite an unsaved configuration. 
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When the update procedure is completed, save the configuration to preserve the updated parameters using either Save 
or Save As from the File menu. 

PRINTING A CONFIGURAPRINTING A CONFIGURATIONTION  
The configuration can only be printed out in the CELite program. Verify that the page and printer settings are correct, 
then click on File, then Print. For further instructions refer to chapter 3. 

DOCUMENT YOUR CONFIGDOCUMENT YOUR CONFIGURATIONURATION  
To generate a listing of all parameters and connections in a configuration, first make sure the desired configuration is opened in the 
CELite program and selected. Then select Document from the File menu. 

This brings up a dialog box in which you name the documentation file and assign it to a directory. 

The default name is the same as the selected configuration with a .doc extension attached. The default directory is the same one that 
holds the selected configuration. Ensure that the name and directory are correct and click on the OK button to create the .doc file. 

Review Your Documentation 
The .doc file containing the configuration documentation may be opened by any word processor or text editor, including the 
Notepad® application bundled with Windows™.  

NoteNote  
You can set up File Manager® to launch Notepad® (or another text editor) automatically when you 
select a .doc file. See your Windows™ manual for instructions on how to do this. 

 

Launch your word processor or text editor and then select the .doc file for your configuration. 

A listing of the configuration parameters will appear on screen. 
 

Print Your Documentation List 
Once you have your configuration documentation open in a word processor or text editor, printing your configurations is simply a 
matter of sending it to a printer connected to your computer. Select Print from the File menu to send the .doc file to your 
printer. 
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Chapter Chapter 55  Starting up a 590+ DriveStarting up a 590+ Drive  

COMMISSIONING THE DRCOMMISSIONING THE DRIVEIVE  
Once the configuration has been created and installed in the drive as described in the previous chapters, the drive is 
ready to be commissioned. If starting with a drive that has a previous configuration installed, go Online then Update the 
CELite configuration first before proceeding. For more details, refer to the previous chapters.  

The CELite+ program guides through the startup process, starting with entering the motor information, entering control 
setup information, performing an autotune and a motor rotation check. Start by going online with the drive. Click the 
Go Online button on the CELite+ home screen. After the Go Online button is green, click on the 
AutoStart123 button. 

 

 

When this screen appears, read the note and click on Continue. 
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MOTOR PARAMETERSMOTOR PARAMETERS  
The motor parameter screen, shown below, shows up next. If the motor information was entered in the configuration in 
CELite, just verify the information. After verifying the entered information, click on Next. Refer to the drive manual if 
you have any questions about the parameters. 

 

WARNINGWARNING  
Make sure all information entered for the motor is exactly as it is shown on the motor nameplate. DO 
NOT enter any information you are not sure is accurate. Contact the motor manufacture if the motor 
information is not available.  

 

WARNINGWARNING  
If the drive is setup for either tachometer or encoder feedback, verify that the tachometer or encoder is 
connected and appropriately calibrated to the drive. 

 

NoteNote  
CELite+ does not support Field weakening setup at this time. It will have to be setup manually after all 
tests have been successfully completed in CELite+. 

The following screen will prompt to download the changes. Click on Yes if any changes have been made or No if not.  

 

NoteNote  
The changes can be downloaded after entering the information in the next section. 
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CONTROL PARAMETERSCONTROL PARAMETERS  
The following display shows the Control Parameters screen. After the information has been entered or verified, click on 
the Next button. Refer to the drive manual for questions on the parameters. 

 

Click on the Yes button in the following window to download the changes into the drive. It will download only new 
information entered in the Motor and Control parameter screens.  

 

After this information is downloaded to the drive, update the CELite configuration by clicking on the Update button 
shown below.  
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AUTOTUNINGAUTOTUNING  
The Autotune screen appears next. 

 

The autotune on a DC drive primarily calibrates the current loop parameters. It tunes the drive to the motor, and is very 
important for proper drive performance. All DC drives should be autotuned. 

This window displays four diagnostic parameters, Coast Stop, Program Stop, External Trip and Enable. These 
parameters are the primary logic inputs on the drive and all must be in a Ready state for the autotune to begin. You can 
click the Refresh button to update the status of these diagnostic values. If any of these values are not ready, check the 
connections on the drive and any safety interlocks.  

Autotune adjusts three current loop parameters Discontinuous current, Proportional gain, and Integral gain. The default 
values are 12.00%, 45.00, and 3.50 respectively. After the autotune has been completed successfully, these values 
should change and must be saved in the drive. CELite+ will prompt to save the parameters after the autotune is finished. 

 

WARNINGWARNING  
During an autotune the shaft may turn, but for more accurate performance the armature should remain 
stationary. If you are tuning a Shunt wound DC motor the shaft should not turn; but it may have enough 
residual magnetism to cause the shaft to turn. If it turns very slowly, the tuning will not be affected. If it 
turns above 10% speed, the shaft must be locked. Stabilized shunt, compound, and permanent magnet 
DC motors all need to have their shafts locked. The locking device should be strong enough to hold the 
full torque of the motor. 

Click on Begin to start the autotune process. After the autotune process begins, the program will prompt to download 
changes to the drive. If the changes have already been downloaded, click No otherwise click Yes.  
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When this warning screen appears, click Yes to continue. 

 

The drive will now try to start the AutoOpen process by pulling in the drive contractor and pulsing the armature with 
current. The process will take about 30 seconds. If it completes successfully, the following screen will appear, click 
Yes to continue to the rotate screen.  

 

The following screens are some of the errors that can pop up during an autotune. 

 

 

If this error appears, check that the: 

1. Armature leads are connected. 

2. Jumper present between drive terminals B3 and A6 
is in place. 

Click on OK to acknowledge error, and retry autotune. 

 

This error will only appear if you stopped the autotune 
using the program or the drive terminals.  

 

Click on OK to acknowledge error, and retry autotune. 

If this error appears, check for: 

1. Motor rotation more than 20% with encoder or 
tachometer feedback. 

2. Improper calibration for the encoder or 
tachometer. 

3. Improper calibration for armature voltage. 

Click on OK to acknowledge error, and retry autotune. 
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MOTOR ROTATE CHECKMOTOR ROTATE CHECK  
Now, you are now ready to check the direction of rotation of the motor and the polarity between the motor and the 
feedback. 

 

This window displays four diagnostic parameters, Coast Stop, Program Stop, External Trip and Enable. These 
parameters are the primary logic inputs on the drive and all must be in a Ready state for the rotate test to begin. Click 
the Refresh button to update the status of these diagnostic values. If any of these values are not Ready, check the 
drive connections and any safety interlocks.  

The speed feedback window reflects the choice set on the motor parameter screen. During this test the program sets 
force the drive to armature voltage feedback to prevent the motor from running away. After the rotate test has been 
completed successfully, the program will prompt to reset the speed feedback back to the original choice. 

Click Begin to start the rotate test. The following screen is to warn that the motor is about to turn. Click Yes to 
continue.  

 

The program memorizes the selected speed feedback and then sets the drive to armature voltage feedback. Then it sends 
a run command to the drive with a 5% speed demand. After the drive starts, the program compares the initial feedback 
source for polarity and scaling to that of the 5% speed demand.  

 

IMPORTANTIMPORTANT  
Do not leave the rotate screen until the test is completed. If the screen is left, the drive will remain in 
Armature voltage feedback and will have to be manually reset. 
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The drive should run for a few seconds and then ask if the direction is correct. The direction of the motor is based on a 
forward (positive) speed demand to the drive. If the direction of the motor is correct for forward, click Yes otherwise 
click No. 

 

Next the program displays one of six messages. If the following message appears, continue with the rotate test. Skip to 
the “Rotation Error” section if any other message appears. Click on OK to continue. A Start button will appear on the 
rotate screen. Click on Start to start the drive. Last the program will prompt to change the speed feedback to the 
initial setting. Click on Yes to switch back to the initial setting, or No to stay in armature voltage feedback. 

Rotation Error 
If one of the following messages appear, follow the directions to correct the problem. Then repeat the rotate test again.  

 

 

 

Motor direction is ok, but the feedback is missing.  

Check the following: 

1. Tachometer or Encoder feedback board missing or not 
connected.  

2. Feedback source missing or misconnected. 

Check connections, feedback boards, tachs and encoders. 

Click on OK and retry rotating test. 

Motor direction is ok, but the feedback polarity is reversed.  

The following actions are required: 

1. Tachometer feedback – Reverse the two tachometer leads. 

2. Encoder feedback – CELite+ will automatically invert the 
encoder sign bit to correct the polarity. 

Click on OK and retry rotating test. 
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After the rotate test is completed successfully, click the Parameters Save button, click the Update button, and 
then continue running the drive in local mode using the Home screen. If the motor runs satisfactory, commissioning is 
complete.  

Motor direction is reversed and feedback polarity is reversed. 

The following actions are required: 

1. Reverse the two armature leads. 

2. Tachometer feedback – Reverse the two tachometer leads. 

3. Encoder feedback – CELite+ will automatically invert the 
encoder sign bit to correct the polarity. 

Click on OK and retry rotating test. 

 

Motor direction is reversed and feedback is missing. 

Check the following: 

1. Reverse the two armature leads. 

2. Tachometer or Encoder feedback board missing or not 
connected.  

3. Feedback source missing or misconnected. 

Check connections, feedback boards, tachs and encoders. 

Click on OK and retry rotating test. 

Motor direction is reversed and feedback is correct. 

The following action is required: 

1. Reverse the two armature leads.  

Click on OK and retry rotating test. 

 

Motor current not detected or feedback out of range. 

Check the following: 

1. Motor not connected or not properly connected. 

2. Feedback not scaled correctly. 

3. CELite+ timed out or computer resources low.  

Click on OK and retry rotating test. 
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Chapter Chapter 66  Starting up a 650V DriveStarting up a 650V Drive  

COMMISSIONING THE DRCOMMISSIONING THE DRIVEIVE  
Once the configuration has been created and installed in the drive as describe in the previous chapters, the drive is now 
ready to be commissioned. If starting with a drive that has a previous configuration installed, go Online then Update the 
CELite configuration first before proceeding. For more details, refer to the previous chapters.  

The CELite+ program guides through the startup process, starting with entering the motor information, entering control 
setup information, performing an autotune and a motor rotation check. Start by going online with the drive. Click the 
Go Online button on the CELite+ home screen. After the Go Online button is green, click on the 
AutoStart123 button. 

 

When this screen appears read the note and click on Continue. 
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MOTOR PARAMETERSMOTOR PARAMETERS  
The motor parameter screen, shown below, shows up next. If the motor information was entered in the configuration in 
CELite, just verify the information. After verifying the entered information, click on Next. Refer to the drive manual 
for questions on the parameters. 

 

 

WARNING!WARNING!  
Make sure all information entered for the motor is exactly as it is shown on the motor nameplate. DO 
NOT enter any information you are not sure is accurate. Contact the motor manufacture if the motor 
information is not available.  

 

There are two different modes of operation the 650V can be setup for, Volts/Hz, and Sensorless Vector. Each one of the 
modes has specific parameters that need to be entered. After choosing one of the modes, CELite+ will show the 
parameters needed for the specific control mode.  

The following is a brief description of the three control modes:  

• The Volts/Hz mode is open loop and requires no speed feedback. Enter in the appropriate information and go on to 
the control parameter section. 

• The Sensorless Vector mode is also open loop, but it has better torque and speed regulation. Enter in the 
appropriate information and go on to the control parameter section. 

For more information on the different options and control modes refer to the drive manual. 
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CONTROL PARAMCONTROL PARAMETERSETERS  
The following display shows the Control Parameters screen. After the information has been entered or verified, click on 
the Next button. Refer to the drive manual for questions on the parameters. 

 

In the vector mode, the motor current is equal to the Magnetizing current and the load current; Torque is equal to the 
load only. 

The dynamic braking can only be setup on drives that have been fitted with the braking transistor. Refer the to the 
model number and the drive manual to verify if the drive has this option. 

After the information has been entered, click on the Download Changes button to download to the drive. 

 

The Download Changes button will only change the information entered in the two parameter screens.  The 
program may automatically prompt to download changes, if so click on Yes. 

 

 

 

 

If the drive is setup for Volts/Hz mode, the program will skip the autotune screen.  
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AUTOTUNEAUTOTUNE  
The Autotune screen appears next. The autotune is only required for the vector mode. 

 

Warning!Warning!  
To perform an autotune on an AC drive, the motor has to be able to turn freely. To achieve the best 
results the motor shaft must not be connected to any device (Like Gearboxes, pulleys, couplings, etc.). 
Before attempting an autotune, all motor parameters MUST be entered into the drive. 

 

This window displays four diagnostic parameters, Coast Stop, Fast Stop, Contactor Closed, and Enable. These 
parameters are the primary logic inputs on the drive and all must be in a Ready state for the autotune to begin. Click the 
Refresh button to update the status of these diagnostic values. If any of these values are not Ready, check the 
connections on the drive and any safety interlocks.  

There are two modes of autotuning on an AC drive, Stationary and Rotating. The preferred mode is the rotating 
autotune. There are many parameters the autotune will adjust in the drive, only five of those parameters are shown on 
the autotune screen. After the autotune has been completed successfully, these values should change and must be saved 
to the drive. 

Click on the white circle next to the mode of autotuning to be preformed. A black dot should appear in the circle and a 
warning window will appear. Skip to the appropriate section below. 

 

  

 

 

 

 

 

 

 

 

 



Chapter 6 Starting up a 650V Drive 

ConfigEd Lite Plus 33 

Stationary Autotune 
The Stationary Autotune should only be used if the motor cannot spin freely. During this autotune the motor will not 
spin, and it will only identify a limited set of motor characteristics. The following are some of the drawbacks to a 
stationary autotune: 

• User has to enter the correct value of magnetizing current. 

• Cannot operate the motor above base speed. 

• User has to manually check the encoder polarity and adjust if necessary. 

 

If Stationary Autotune is chosen, the following window will appear. Click on OK, and compare the Magnetizing current 
value shown on the screen to that on the motor nameplate. If the value is wrong, enter the proper value and continue.  

 

Click on Begin to start the autotune process. The following window will appear to warn that the program will assume 
control of the drive. Click on Yes to continue. 

 

CELite+ will now perform an autotune on the drive. If the autotune completes successfully the following window will 
appear. Click on Yes, and proceed to the Home screen to run the drive. If an error occurs skip to the Autotune error 
section. 
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Rotating Autotune 
The Rotating Autotune mode of tuning will give the best performance of the drive. The motor shaft will spin from zero 
to base speed and then to maximum speed. This mode of tuning will also check the encoder feedback polarity, and 
toggle the encoder polarity if necessary. The following are some drawbacks to a rotating autotune: 

• The motor shaft cannot be connected to anything. 

• The tuning process can only characterize the motor up to 30% above the Max speed. If you need to go 
faster than this speed, perform another autotune. 

If Rotating Autotune is chosen, the following window will appear, Click on OK to continue. 

 

Click on Begin to start the autotune process. The following window will appear. Click on Yes to continue. 

 

Next the program displays a warning that it will assume control of the drive. Click on Yes to continue. 

CELite+ will now perform an autotune on the drive. If the autotune completes successfully the following message will 
appear. Click on Yes and proceed to the Home screen to run the drive. If an error occurs skip to the Autotune error 
section. 
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Autotune Errors 
Below are some of the errors that can occur during an autotune. 

 

 

 

 

 

 

 

 

 

After autotune has completed successfully, continue to the home screen section. 

 

 

 

This error will only appear if you stopped the autotune 
using the program or the drive terminals.  

 

Click on OK to acknowledge error and retry autotune. 

If this error appears, check the following: 

1. Coast stop, fast stop, enable, external trip, and motor thermal 
are all high. 

2. CELite+ is still in control of the drive. 

Click on OK to acknowledge error and retry autotune. 

If this window appears you do not need to preform an autotune 

 

Click on OK and proceed to the home screen section. 

There are multiple errors that can appear in this 
window, please refer to the 650 installation 
manual, Trips and Fault Finding chapter, for 
more information. 

 

Click on OK to acknowledge error and retry 
autotune. 
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Chapter Chapter 77  Starting up a 690+ DriveStarting up a 690+ Drive  

COMMISSIONING THE DRCOMMISSIONING THE DRIVEIVE  
Once the configuration has been created and installed in the drive as describe in the previous chapters, the drive is now 
ready to be commissioned. If starting with a drive that has a previous configuration installed, go Online then Update the 
CELite configuration first before proceeding. For more details, refer to the previous chapters.  

The CELite+ program guides through the startup process, starting with entering the motor information, entering control 
setup information, performing an autotune and a motor rotation check. Start by going online with the drive. Click the 
Go Online button on the CELite+ home screen. After the Go Online button is green, click on the 
AutoStart123 button. 

 

When this screen appears read the note and click on Continue. 

 



Chapter 7 Starting up a 690+ Drive 

 38 ConfigEd Lite Plus 

MOTOR PARAMETERSMOTOR PARAMETERS  
The motor parameter screen, shown below, shows up next. If the motor information was entered in the configuration in 
CELite, just verify the information. After verifying the entered information, click on Next. Refer to the drive manual 
for questions on the parameters. 

 

 

WARNING!WARNING!  
Make sure all information entered for the motor is exactly as it is shown on the motor nameplate. DO 
NOT enter any information you are not sure is accurate. Contact the motor manufacture if the motor 
information is not available.  

 

There are three different modes of operation the 690+, Volts/Hz, Sensorless Vector, and Closed Loop Vector. Each one 
of the modes has specific parameters that need to be entered. After choosing one of the modes, CELite+ will show the 
parameters needed for the specific control mode.  

The following is a brief description of the three control modes:  

• The Volts/Hz mode is open loop and requires no speed feedback. Enter in the appropriate information and go on to 
the control parameter section. 

• The Sensorless Vector mode is also open loop, but it has better torque and speed regulation. Enter in the 
appropriate information and go on to the control parameter section. 

• The Closed Loop Vector mode requires encoder feedback to close the speed loop. It has very good torque and 
speed regulation. The encoder feedback can be connected through an Encoder techbox or system board. Enter in 
the appropriate information and go on to the control parameter section. 

For more information on the different options and control modes refer to the drive manual. 
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CONTROL PARAMETERSCONTROL PARAMETERS  
The following display shows the Control Parameters screen. After the information has been entered or verified, click on 
the Next button. Refer to the drive manual for questions on the parameters. 

 

In the vector modes, the motor current is equal to the Magnetizing current and the load current; Torque is equal to the 
load only. 

The dynamic braking can only be setup on drives that have been fitted with the braking transistor. Refer the to the 
model number and the drive manual to verify if the drive has this option. 

After you are finished with this screen you should download the information you have entered. Click on the Download 
Changes button to accomplish this. 

 

The Download Changes button will only change the information entered in the two parameter screens. The program 
may prompt to download changes, if so click Yes. 

 

 

 

If the drive is setup for Volts/Hz mode, the program will skip the autotune screen.  
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AUTOTUNEAUTOTUNE  
The Autotune screen appears next. The autotune is only required for the vector modes. 

 

WARNING!WARNING!  
To perform an autotune on an AC drive, the motor has to be able to turn freely. To achieve the best 
results the motor shaft must not be connected to any device (Like Gearboxes, pulleys, couplings, etc.). 
Before attempting an autotune, all motor parameters MUST be entered into the drive. 

 

This window displays four diagnostic parameters, Coast Stop, Fast Stop, Contactor Closed, and Enable. These 
parameters are the primary logic inputs on the drive and all must be in a Ready state for the autotune to begin. You can 
click the Refresh button to update the status of these diagnostic values. If any of these values are not Ready, check 
the connections on the drive and any safety interlocks.  

There are two modes of autotuning on an AC drive, Stationary and Rotating. The preferred mode is the rotating 
autotune. There are many parameters the autotune will adjust in the drive, only five of those parameters are shown on 
the autotune screen. After the autotune has been completed successfully, these values should change and must be saved 
to the drive. 

Click on the white circle next to the mode of autotuning to be preformed. A black dot should appear in the circle and a 
warning window will appear. Skip to the appropriate section below. 
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Stationary Autotune 
The Stationary Autotune should only be used if the motor can not spin freely. During this autotune the motor will not 
spin, and it will only identify a limited set of motor characteristics. The following are some of the drawbacks to a 
stationary autotune: 

• User has to enter the correct value of magnetizing current. 

• Cannot operate the motor above base speed. 

• User has to manually check the encoder polarity and adjust if necessary. 

 

If Stationary Autotune is chosen, the following window will appear. Click on OK, and compare the Magnetizing current 
value shown on the screen to that on the motor nameplate. If the value is wrong, enter the proper value and continue.  

 

Click on Begin to start the autotune process. The following window will appear to warn that the program will assume 
control of the drive. Click on Yes to continue. 

 

CELite+ will now perform an autotune on the drive. If the autotune completes successfully the following window will 
appear. Click on Yes, and proceed to the Home screen to run the drive. If an error occurs skip to the Autotune error 
section. 
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Rotating Autotune 
The Rotating Autotune mode of tuning will give the best performance of the drive, especially in closed loop vector 
mode. The motor shaft will spin from zero to base speed and then to maximum speed. This mode of tuning will also 
check the encoder feedback polarity and toggle the encoder polarity if necessary. The following are some drawbacks to 
a rotating autotune: 

• The motor shaft cannot be connected to anything. 

• The tuning process can only characterize the motor up to 30% above the Max speed. If you need to go 
faster than this speed, perform another autotune. 

If Rotating Autotune is chosen, the following window will appear, Click on OK to continue. 

 

Click on Begin to start the autotune process. The following window will appear. Click on Yes to continue. 

 

 Next the program displays a warning that it will assume control of the drive. Click on Yes to continue. 

CELite+ will now perform an autotune on the drive. If the autotune completes successfully the following message will 
appear. Click on Yes and proceed to the Home screen to run the drive. If an error occurs skip to the Autotune error 
section. 
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Autotune Errors 
Below are some of the errors that can occur during an autotune. 

 

 

 

 

 

 

 

 

 

After autotune has completed successfully, continue to the home screen section. 

 

 

 

This error will only appear if you stopped the autotune 
using the program or the drive terminals.  

 

Click on OK to acknowledge error and retry autotune. 

If this error appears, check the following: 

3. Coast stop, fast stop, enable, external trip, and motor thermal 
are all high. 

4. CELite+ is still in control of the drive. 

Click on OK to acknowledge error and retry autotune. 

If this window appears you do not need to perform an autotune 

 

Click on OK and proceed to the home screen section. 

There are multiple errors that can appear in this 
window, please refer to the 690+ installation 
manual, Trips and Fault Finding chapter, for 
more information. 

 

Click on OK to acknowledge error and retry 
autotune. 
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Chapter Chapter 88  Home ScreenHome Screen  
After the drive has been configured, setup, and autotuned, it is ready to be run using the Home screen. It is basically a 
software version of the keypad on the drive. CELite+ will control the drive through the serial port on the drive. To use 
this screen, you will have to be ONLINE. 

 

WARNING!WARNING!  
Before running the drive make sure everyone is clear of the motor. Make sure all interlocks and 
emergency stops are wired and operational, and that the motor is properly mounted. 

RUNNING THE DRIVERUNNING THE DRIVE  
The following functions are needed to run the drive. To activate a function, click on the desired button with the cursor. 

• RUN – Send a run command to the drive. 

• STOP – Send a stop command to the drive. 

• LOC – In this switch position, the drive will be in Local mode and is controlled by CELite+ or the keypad on the 
drive. 

• REM - In this switch position, the drive will be in Remote mode and is controlled by terminals on the drive. 

• FWD – In this switch position, the drive will rotate in a forward direction. 
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• REV – In this switch position, the drive will rotate in a reverse direction. 

• RESET – To reset the drive if a fault occurs. Fault information will be shown below the RESET button. 

• Setpoint – Send a speed demand to the drive. Drag the dial with the cursor to increase or decrease the speed 
setpoint or double-click inside the dial to type in a speed setpoint. 

• Current Setpoint – Send a current demand to the drive. Drag the dial with the cursor to increase or decrease 
the current setpoint or double-click inside the dial to type in a current setpoint. 

• Meters – These meters have a digital and a needle readout.  

• Speed % - Speed feedback on the drive. 

• Current % - Current feedback on the drive. 

• Torque % - Torque feedback on the AC drives only. 

 

WARNING!WARNING!  
Do not click the OFFLINE button or close the software while running the drive with the Home screen. 

To run the drive, simply click on the RUN button and dial in the desired speed demand. Watch the meters for speed 
feedback and current feedback to ensure proper performance. 

PARAMETER LIST VIEWSPARAMETER LIST VIEWS  
The parameter list views show the drive parameters in a spreadsheet format. Click on the + sign to expand the 
Parameter List Views in the tree view window. 

There are four basic lists of parameters, Different from Default, Custom Monitoring, All and Setup. The parameter 
lists are defined as follows: 

1. Different from Default – a listing of only the parameters different from the factory default values. 

2. Custom Monitoring – a listing of only the parameters chosen by the user to be displayed. 

3. All – a listing of all the drive parameters. 

4. Setup – the parameters listed in the appropriate function they perform in the drive. 

Click on the + sign to expand a list in the above tree view window and – to compress a list. 
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To open a List view, click the desired list view in the tree view window. The Parameter List View window appears as 
the following: 

 

The top task bar shows which list view is being shown. The following buttons can be used to move between the list 
views: 

1. Prev – Go to the previous list view. If you are at the first list view, it will go to the last list view. 

2. Next -  Go to the next list view. If you are at the last it will go to the first list view. 

3. Exit – Return to the home screen. 

The following is a listing of the information in the window. 

1. Description window – detailed information on the highlighted parameter. 

2. Parameter list window- multiple columns of information listed from left to right below: 

1. Tag – Parameter number in the drive 

2. Tag Name – Parameter name 

3. Drive – Parameter value from the drive 

4. Configured Value – Parameter value from the CELite configuration 

5. Default – Parameter value factory default  

6. Range – Range for the given parameter 

7. T, M – Trace on Chart or Monitor this parameter.  ONLY the parameters on the Monitor list will be 
modifiable while Charting. 

3. List Only Modified – Only shows the parameters changed and pending Download which are viewable on 
the current list view 

4. Auto Download on – Automatically download any changed value in the list view after this function is 
checked. 

5. Print Form – print all parameters in the current list view.  If the user is on the “All” Listview, this is a large 
amount of documentation. 
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6. Total – Total number of parameters in the current list view. 

By default the list views display the information sorted by the tag number. The list view can be toggled between 
ascending and descending order by clicking on the Tag# button and changing the direction of the arrow. The list 
view can also be toggled between alphabetical or reverse alphabetical order by clicking on the Tag Name button. 

Any parameter can be changed by clicking on it in the Configured Value column and entering in the value.  

 

Once a value has been changed it will be highlighted until it is downloaded into the drive. The new information will 
not be downloaded to the drive until the Download Changes button is clicked, unless the AUTO DOWNLOAD ON 
has been checked. The following window will appear to warn that the program is about to download the information 
to the drive. 

NoteNote  
Any parameters that were changed before this function is checked must be downloaded with the 
Download Changes button. 

 

To view a list of all the parameters that have been changed in the list views, click on the List Only Modified 
button. The button will only appear after a parameter has been modified in the list views. 
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The Print Form button will print all the parameters in the current list view only. It will print in a landscape page 
format, with approximately 29 parameters per page. 

NoteNote  
Double clicking on the Tag Name will refresh the parameter value from the drive when online.  Clicking 
on the Refresh button at the bottom of the screen will refresh the entire current List View. 

ONLINE MONITORINGONLINE MONITORING  
To send a parameter either to the online Chart or the Custom Monitoring list view, click on the T, M column  
for the given parameter. The following window will appear: 

 

 

The Custom Monitoring List is a special list view that will scan the drive and update the parameter with each 
scan.  Only these parameters may be modified when Charting.   To add a parameter to the list, click on Add. To 
remove a parameter from the list, click on Remove. Once a choice has made, click on OK. After the above window is 
closed, there will be an M in the T,M column for the parameter added to the list. Skip to the Custom Monitoring 
section for more information. 

The Chart function is a software version of a chart recorder. To add the parameter to the chart, first choose one of 
the channels, 1 – 4, for the parameter to be displayed, then click on Add. To remove a parameter from the chart, 
choose the channel to be removed and then click on Remove. Once a choice has made, click on OK. After the above 
window is closed, there should be a 1 - 4 in the T,M column for the parameter added to the list. This identifies the 
channel the parameter will be shown on the chart. Skip to the Chart section for more information. 
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Custom Monitoring List View 
The Custom Monitoring window displays the parameters selected in the previous section. There are two ways to 
open the window. Click on Custom Monitoring on the tree view window or click on the Watch button on the 
home screen. 

 

 

When the Custom Monitoring list view is open, CELite+ will continually update the parameters on the list. The 
parameter values appear in the Drive column of the window. The green Scanning Drive LED will flash on and 
off during normal operation.  
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Chart Function 
NoteNote  

To chart drive values, go Online before opening the Chart window.  To Run the drive from the Chart 
screen the application must also set the drive in Local before opening the Chart window. 

The chart function allows the user to chart up to four drive parameters. There are two ways to start Chart function. 
Click on Chart, under the Tree View window or click on the Chart button in the home screen. 

 

The following is the chart window: 
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The bottom of the chart window shows the 4 channels and the parameters chosen to be charted. Each channel will show 
the parameter number, parameter name and a digital readout of the parameter. The parameter being charted can be 
changed by clicking, with the right mouse button, on the channel to be changed and typing in the new parameter. 

Each channel can be turned on or off by clicking, with the left mouse button, on the little white box to the right of the 
parameter number. The color legend for each channel is shown in the upper right hand corner of the chart window. 

The time base of the chart can be change by clicking on the sec/Div arrow and selecting the desired time base. The 
time base should only be changed while the chart is stopped. 

The Start and Stop buttons under the time base are used to start or stop the charting. Click on Exit to close the 
chart window. 

The Start and Stop buttons under Drive are used to start and stop the drive while on the chart page. The highlight 
on the buttons will show the mode the drive is in, Red for stopped and Green for running. 

The Change a Drive Value button is used for changing a parameter in the drive while on the chart page. The 
only stipulation is that the parameter to be change must be added to the Custom Monitor list view before running 
the chart function.  

Once a channel has been turned on, a vertical scale will appear to the left of the chart window with the color of the 
channel turned on. An example is shown below, channel 1 was turned on so a red vertical scale appeared.  

 

The buttons that appear on the top of the chart have the following functions, starting with the left most button and 
working to the right: 

1. Resume – Resumes scrolling of chart. 

2. Pause – Pauses scrolling of chart. 

3. Scroll mode – Use the cursor to scroll through the axes on the channel highlighted. 

4. Zoom mode – Use the cursor to Zoom through the axes on the channel highlighted. 

5. Zoom in – Zoom all axes in by a factor of x2 on all channels. 

6. Zoom out – Zoom all axes out by a factor of x2 on all channels. 

7. Zoom box – Draw a box on chart data to Zoom in on all axes on all channels. 

8. Cursor – Draw a line in the chart area to define a given point on the trace on the channel highlighted. 

9. Edit – Change properties for all aspects of the chart. This button is only available when chart is stopped. 

10. Copy – Copy the current chart data to the clipboard. 

11. Save – Save current chart data to a file. 

12. Print – Print current chart data to the printer. 

To scale the y-axis, edit the chart by modifying the Min and the Span of the y-axis of the Channel in question. 

 

For more information on the chart function, refer to the plot pack version 2.0 manual. A copy of the manual can be 
downloaded at www.iocomp.com. 
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Chapter Chapter 99  Troubleshooting Troubleshooting   

MISMATCHED BAUD RATEMISMATCHED BAUD RATESS  
The baud rates in the drive must match those in CELite+. Check the BAUD RATE setting on the drive under SERIAL LINKS. 
Clicking on Reset in the Comms menu will cause the application to reset the comms port and automatically try to find the correct 
baud rate required to communicate with the drive.  CELite+ will only check COM1 and COM2 in this process.  Using any other 
comm. Port will require the user to manually configure the setting in the Comms Menu::Settings. 

BAUD RATE SET TOO HIBAUD RATE SET TOO HIGHGH  
Some older IBM-compatible computers can experience difficulty with the 19200 baud rate. For those computers, reduce 
the baud rate until reliable communications occur or to 9600 on the drive and do a Comms::Reset in CELite+. 

WRONG COMMUNICATIONSWRONG COMMUNICATIONS PORT PORT  
If the comm port is other than COM1 and COM2 go to the Command Comms menu, select another communications 
port, and ensure your drive is connected to that port. 

DRIVE P3 MODE SET WRDRIVE P3 MODE SET WRONGONG  
For a 590+ series drive, set: 

SERIAL LINKS::SYSTEM PORT::P3 SETUP::MODE to IPS (ASCII)  

SERIAL LINKS::SYSTEM PORT::P3 SETUP::P3 BAUD RATE to 19200.   

For 650V drives, no special settings are required to communicate with ConfigEd Lite Plus. Simply plug into the 
appropriate serial port on the drive. 

NotNotee  
Not all 650V drives are fitted with a P3 serial port, refer to drive manual for more information. 

 

For a 690+ series drive, set: 

SETUP::COMMUNICATIONS::SYSTEM PORT (P3)::MODE to EI ASCII   

The baud rate is fixed at 19200  
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ERROR MESSAGESERROR MESSAGES  
Error detection is designed into ConfigEd Lite to help prevent the execution of an inappropriate or dangerous command. 
ConfigEd Lite displays error messages when it discovers a problem. The messages contain an error number and a brief 
description. Some messages also have an error code expressed as PNO plus a two-character code identifying the type of 
error. In case of irreconcilable errors, the error and code numbers may help the service technician help solve the 
problem. 

The most common error messages are as follows: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 
 
 
 

 

 

 

 

 

 

 

CautionCaution  
If CELite aborts during installation, it is possible that an “anti-virus” program is running on the computer. Close the program and try 
again. 

Code – Error #6453 Serial Comms failed. 
 
Description – Serial comms has not responded as expected.  
PNO II,  indicates that it failed to read ID (II). 

Action –  
• Ensure drive has power and the cable is plugged into 

the correct correct serial port. 

• Set port in ASCII mode and ensure that baud rate of 
drive  matches that of ConfigEdLite. If not, 
communications will resume only if the baud rate 
setting in the drive MMI is reset to match 
ConfigEdLite. 

• Group ID and Unit ID must be set to “0” 

• CONFIGURE I/O parameter must be “Disabled” 

Code – Error #6449 Serial Comms failed. 

 
Description – Marginal or interrupted communications 

 

Action –  
• Reduce baud rate settings on drive and ConfigEdLite 

(This is not possible for 584S & 605 drives) 

• Reset the port by cycling power to the drive 

• Cable damaged? Cable should not be longer than 10 
feet. 

Code – Error #6405 Could not access 
configuration. 

 
Description – Could not find the “.dat” file in the 
directory. 

 

Action –  
• Make sure the correct celite.dat file is in the 

same directory as your application . 

Code – Error #6459 Could not open Serial 
Comms Library. 

 
Description – The Comms port on the computer is not 
active, turned off, or used by another device. 

 

Action –  
• Check comms port allocation and settings 
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Chapter Chapter 1010  AppendixAppendix  

CELITE+ CELITE+   

Home Screen Buttons 
Online will attempt to establish communications with the drive or indicate to the user, the application is already 
communicating with the drive 

Offline will close communications with the drive or indicate to the user the application is already offline. 

Download Changes will send pending changes to the drive if the application is Online.  Downloading changes does not 
save the changes in the drive (Parameter Save) or to the configuration (File Save). 

Refresh requests the immediate values on the current display (only) from the drive and then refreshes the current display.   

Parameter Save sends the drive the parameter save command. 

AutoStart123 steps the user through a quick and simple setup of a drive.   The sequence steps through the setup of motor, 
control parameters, and an autotune. 

Scope is currently unavailable. 

Chart utility allows the user to graphically monitor up to for values from the drive.  Right-clicking on the Chart will allow 
the user to modify certain features. The Chart utility offers many features which are documented in the User Manual. 

Watch is a digital display of drive values the user selected to monitor from a List View.  The display is continuously refreshed 
from the drive when the application is online. 

Install is a command to install the current CELite configuration into the drive.  .  This is only available when online. 

Update is a command to update the current configuration from the drive into the CELite configuration.  This is only available 
when online. 

Graphics displays the current configuration in the ConfigEd Lite graphical format. 

Home returns to the Home screen. 

LED is a visual cue for the state of the drive and when on a screen other than the Main screen, clicking on the LED will allow 
the user to reset the drive. 

Tree View allows the user an alternative means to operate the software. 

List Views allow the user to view the drive value when online.  The user may also view the default values of the drive 
parameters.  The configured value represents the value the user has set either through a configuration file or immediate 
parameter change.  A highlighted configured value indicates the user has modified the configured value and the modification 
has not been given to the drive.  To view a list of parameters pending download to the drive, click on the List Only Modified 
button.  Any pending change may be modified or removed from the pending download list prior to a Download Changes 
command.  A List View also provides the user with a means to add a parameter to the Online Diagnostics display as well as the 
Chart and Scope display.   

System Messages/Alarms are visible as the event occurs at the bottom of the screen.  Some messages are classified as 
Alert messages which will be sent to the user unless the feature is disabled under the Tools-Options menu selection 
(Acknowledgement Requirements for Alerts).  Many messages are simply informative and do not require action. 
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CELITECELITE  

Drawing 
The ability to create configurations in a graphical display on screen is a key feature of ConfigEd Lite. The Draw menu 
contains a variety of tools to assist you in your work. It provides functions to move among multiple sheets of drawings, 
create custom outline forms, and annotate drawings with important information.  

Additional commands in the Draw menu include Oval, Color, Fill, Pattern, and Width. These commands are 
used to modify objects drawn in or text added to the configuration. The color, fill, or width of the lines of function 
blocks and connecting lines cannot be modified. Only objects or lines you have drawn in a configuration can be 
modified with these tools. 

To apply Color, Fill, Pattern, or Width commands to an existing object, select the object with the mouse 
pointer. As an example, we will use a box created in a blank configuration using the Rectangle tool. After creating 
the box, select it with the mouse pointer and then go to the draw menu and select Pattern. 

A pop up list of pattern options will appear on screen; Hollow is the default pattern. Select a different pattern (for 
example, Solid) with the mouse and release the mouse key. The box will automatically be filled on screen. For 
illustration purposes, Black has been selected as the Fill color; the default fill is White. 

The same sequence of steps can be used to modify the color of text or graphics, the width of lines (either alone or as 
part of a drawn object), and the fill of a drawn object. 

Note 
Pressing the Ctrl key after use of any drawing tool causes ConfigEd Lite to “remember” the last drawing action taken 
(whether drawing lines, arrows, or shapes, or adding text) and allows you to immediately repeat that action. This saves 
the time and effort of repeatedly selecting the tool from the Draw menu. 

Drawing Tools 
Color 

The Color command is used to specify the outline color for rectangles and ovals and the display color for lines, 
arrows, and text you have added to your drawing. 

To apply color to an object or text, either select a color and then a line or object to draw or text to place, or select an 
already-placed object or block of text and then change the color. The default color setting is Black. 

Fill 

The Fill command is used to color the contents of an object and highlight its appearance on a color display. To 
change the color for new objects, select Fill and choose the new color. All new objects will be drawn with that color. 

To change the fill color of an existing object, select the object. Then select Fill and choose the new color. The default 
color is White. 

Pattern 

The Pattern command is used to set the fill pattern of an object. To change the fill pattern for new objects, select 
Pattern and choose the new style. All new objects will be drawn with that fill pattern. 

To change the fill pattern of an existing object, select the object. Then select Pattern and choose the new fill pattern. 
The default Pattern setting is Hollow. 

Width 

The Width command is used to specify the thickness of lines created with the Arrow, Line, Oval, and Rectangle 
commands. One point is equal to 1/72 of an inch. Line width ranges from 0.5 points to 16.0 points; the default line width 
is 0.5 points. 

To get an idea of the differences in line widths, select the oval drawn previously and change the line using the Width 
tool. Notice the difference in the oval when the line is changed. The Width setting is also used for all newly-drawn 
objects. 
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Arrow 

The Arrow command is a variant of the Line command. It is used to add lines with arrows to your drawings. 
Combined with text and other tools, arrows can be an effective tool to bring attention to a particular item. 

Line 

The Line command allows you to draw straight lines anywhere in your drawing. It can be used to create form outlines 
and text boxes, and to add highlighting to drawings. When you select Line from the Draw menu, your mouse pointer 
turns into an X, showing it is now a drawing tool. Place the X where you want to begin your line, press and hold the 
mouse key down, and drag a line to the desired end point. 

Release the mouse key when your line is finished. To draw a series of connected lines, hold the Ctrl key down when 
you click the mouse the second time. A new line, starting where the first one finished, can then be dragged with the 
mouse. 

Oval 

The Oval command allows you to add an oval or circle to your drawing. When you create an oval on screen, the 
borders formed during the drawing process are rectangular. Only after you release the mouse key does the oval appear. 
When you select the oval to move it or modify its shape, it is highlighted by a rectangular gray box outlining its 
perimeter. 

Rectangle 

The Rectangle command allows you to add a rectangle to your drawing. 

Text 

The Text command allows you to add text to your drawing. It is covered in depth in Chapter 6. 

Display Options 
The Scale and Black & White display options are used to change the view of a configuration on your computer 
screen. 

Scale 

The Scale command is used to select the magnification ratio of your configuration display. The Scale menu presents 
a list of preset ratios as well as a Variable dialog function. The Variable dialog asks for a magnification setting 
within the range of .34x to 10x. The default Variable setting is the current viewing scale. 

Keyboard commands may also be used to change scaling. See page 4-2 for a list of keyboard scaling commands. 

Black & White 

The Black & White command is used to switch the display of your configuration from color to black and white 
mode. This is useful when taking a drawing created on a color monitor and viewing it on a black and white monitor. It 
is also used when sending a color or configuration to a black and white printer. With this command toggled on, it 
prevents printing the drawing in gray scale, which may result in poor printout quality. 

Annotating Drawings 
Objects and/or text may be added to your drawings in the same manner as is used for creating forms. The only 
difference is that such annotations are usually made on individual configuration sheets rather than on sheet 0. 

Review the sections on using the drawing tools to add text or graphics to your configuration drawings. 
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Scratch Pad 
The scratch pad provides a written record of your actions regarding the configurations, including loading, saving, and deleting 
drawings.  That record is kept in the celite.tex file, which is created automatically when you first launch ConfigEd 
Lite.  Every time the program is run, the information written to the scratch pad is added to the end of the celite.tex 
file.  It is located in the working directory for the ConfigEd Lite icon, typically the celite directory.  The 
celite.tex file may be edited using any text or word processing program that reads text files. 

The scratch pad window appears on screen whenever ConfigEd Lite is launched. It responds to the same sizing 
commands and actions as any other Windows™ element. 

The launch time for ConfigEd Lite is recorded automatically in the scratch pad when the program opens. You can 
manually insert the current time at any point by selecting Paste Time from the Edit menu. 

You can select the typeface and size for the information in the scratch pad by first making sure it is the active window. 
Next, go to the Font and Style menus and select the typeface and size you prefer. The type in the scratch pad will 
change to the style you specified. The style selected for the scratch pad will also become the default for text you add to 
your configuration drawings, so choose it with care. A sans serif typeface, such as Helvetica, will be the clearest and 
easiest to read in your drawings and is recommended for that reason. Type that is automatically included with function 
blocks retains its default font regardless of the style chosen for the scratch pad. 

To print out your ConfigEd Lite Scratch Pad records: 

1.Launch a text editor or word processing program, such as the Windows™ Notepad®; 

2.Select Open from the File menu; 

3.Locate and open the celite directory; 

4.Search for files with .tex in the file name; 

5.Select celite.tex from the menu of files; 

6.Select Print from the File menu once the file is opened. 

You can also use the ConfigEd Lite Scratch Pad as a simple text editor to make notes on the actions recorded there. To 
add text manually, make sure that the scratch pad window is active and that you can see a blinking cursor. Then add 
whatever notations you wish by typing them in from the keyboard. 

It is a good idea to edit your celite.tex file periodically, as it can grow quite large. Before deleting portions of the 
file or the entire file, make a copy (either printed or saved to a floppy disk) to retain for your records. This record is 
invaluable in tracking installations, modifications, and other actions regarding ConfigEd Lite. 

You can either select portions of the file to delete while in your text editor or word processor or delete the entire file 
from your hard drive. If you delete the entire file, ConfigEd Lite will create a new celite.tex file the next time it is 
launched. 

To clear the text displayed in the scratch pad window, make sure it is the active window and then choose Save from 
the File menu. This saves the text to disk and clears the on-screen display of the scratch pad information. 
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